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Syukur ke hadrat llahi kerana dengan izin dan inayah-Nya dapat kita bersua la uletin Geospatial Negeri
Perak Edisi Bil. 2 Tahun 2015 yang berjaya diterbitkan. Setinggi-tinggi penghargaan dan ucapan tenma ka5| j saya
kepada barisan redaksi dan semua yang terlibat dalam menjayakan penerbitan buletin ini.

Antara intipati kandungan buletin kali ini merangkumi lima (5) rencana teknikal yang dapat dibaca oleh pembaca
bagi meningkatkan pengetahuan dalam bidang geospatial dan bidang yang berkaitan dengannya. Antaranya adalah
Info Teknologi Maklumat (IT) yang menitikberatkan isu keselamatan maklumat penggunaan telefon pintar dari aspek
risiko, ancaman serta langkah keselamatan, pengenalan kepada data Light Detection and Ranging (LIDAR), Peta
Interaktif PerakGIS memaparkan beberapa modul dan submodul yang telah siap dihasilkan oleh Unit PerakGIS,
membuat penambahan atau perubahan pada maklumat attribute menggunakan Quantum GIS dan gambar-gambar
Hari Terbuka Unit PerakGIS di dalam Aktiviti.

Kelestarian penerbitan ilmiah ini harus dilihat sebagai satu usaha murni dalam mempromosikan pengetahuan
berkaitan geospatial kepada pengguna geospatial. Saya berharap segala inisiatif yang diambil oleh Unit PerakGIS
ini dapat mempromosikan aktiviti geospatial pada tahap yang lebih meluas dan dimanfaatkan oleh semua pihak.

Sekian, terima kasih & selamat membaca.
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LiDAR

Apa itu LiDAR?

LiDAR (Light Detection And Ranging) merupakan teknologi Remote Sensing Optikal yang boleh mengukur jarak
menggunakan cahaya laser. LIDAR menggunakan panjang gelombang yang pendek iaitu ultraungu (ultraviolet),
cahaya nampak (visible) dan cahaya inframerah (infrared).

LiDAR sangat sensitif kepada objek bukan logam, aerosol dan partikel-partikel awan. la kini diterima umum
sebagai teknik yang paling sesuai untuk menghasilkan data ketinggian yang tepat dengan cara yang cepat dan
kos efektif.

Jenis - Jenis LIiDAR

Berdasarkan Pembalikan Lain - lain
- Rayleigh LiDAR - Coherent LIDAR (phase sensitive)
- Mie LIDAR - Incoherent LIDAR (amplitude measurement)
- Raman LiDAR

Komponen LiDAR

1. LASER

2. SCANNER & OPTICS

3. PHOTODETECTOR & RECIEVER ELECTRONICS
4. POSITION & NAVIGATION SYSTEMS

Aplikasi LIDAR

. Pemetaan Talian Penghantaran (Transmission Line)
. Penyelidikan Kejuruteraan / Pembinaan

. Kajian Eksplorasi Minyak & Gas

. Pemetaan Kawasan Banjir

. Ketenteraan dan Penguatkuasaan Undang-Undang
. Fizik & Astronomi

. Meteorologi & Atmosfera

NO oA WN =

Kebaikan

1. Ketepatan yang tinggi

2. Pengumpulan & pemprosesan yang cepat
3. Kurang penglibatan tenaga manusia

4. Tidak bergantung pada cahaya atau cuaca

Kelemahan

1. Gagal menembusi kanopi yang tebal ( Elavation Model Error )
2. Memerlukan ketepatan ( alingment )

3. Tiada projwntaraban'gsa N &

4. Dataset yang besar : Wores
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Modul ini mengandungi tiga (3) sub modul iaitu Bank, Stesyen Minyak dan Pusat Jualan. Sub modul Bank
memaparkan maklumat lokasi Mesin ATM bagi semua jenis bank di seluruh Negeri Perak. Sub modul Stesyen
Minyak pula memaparkan maklumat lokasi stesyen minyak bagi semua syarikat minyak yang beroperasi di Negeri
Perak. Walau bagaimanapun, hanya lokasi Petronas dan Shell sahaja dipaparkan. Stesyen minyak yang lain masih
dalam proses kemaskini. Sub modul Pusat Jualan pula memaparkan maklumat lokasi pasaraya besar, pasaraya

dan pasar di Negeri Perak. Modul Perdagangan ini sentiasa dikemaskini dari masa ke masa.

Sub Modul Perdagangan: Mesin ATM
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Sub Modul Perdagangan: Stesen Minyak
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Langkah 5 Menambah butiran data. Klik Vector > 7Table Manager. Ataupun klik kanan pada layer > Open At-
tribute Table > Klik Toggle Editing Mode > Klik New columns

[ ————— P S e Pt P S T B ca i st
3 PRSP AY Nl 08-B-5 & = 3 {03 Y S o 311 [ T lmn] ] STl
‘ "BALIAPO R AR B »,q‘ggqq:@e;ﬂ’uv-h-f‘: . )8]| (=) (&) (=) (=] (8] @) @) (=] ] (=) (=) (=]
¥ oo FCD | MM | Nam 8A3 INU LAMAN_WEB NoTeL |

21 Toble Manager: Hospital Perak (0 | 800010 Institutional Bui... | Hospital Slim Ri... | 35800 Slim River |NULL | http:/hstmoh.... |05-4526467 0§

[ —— Zsooom |Institutional Bui.. | Hospital Topah | Jalan Temoh, 35... NULL  httpy//htapah.... |05-4012863 o
= 2 |800010 Institutional Bui... | Hospital Teluk ... | Jalan Changkat .. NULL http://htintan.... |05-6298400 o
] Nome [ 13 | 800010 |Institutional Bui... | Hospital Gerik | Jalan Intan, 333... [NULL NULL 05-7911333 1o
1 it |4 |8D0010 |Institutional Bui... | Hospital Kampar | Jalan Hospital, ... |NULL NULL 05-4653333 I
[2 | |5 |BD0010 | Institutional Bui... | Hospital Parit B... | Jalan Sempada... |NULL | http:/hptar.mo... | 05-7163333 0
;T [ (6 | 800010 Institutional Bui...  Hospital Bahagi... | 31250 Tanjung ... |NULL | http://hbuk.m... |05-5332333 :o
7 7_|B00010 |Institutional Bui... | Hospital Batu G... | Jalan Changkat,... NULL hitp://hbgjh.m... 053663333 ol
o 's_|BD0010 | Institutional Bui...Hospital Raja P..._|Jalan Hospital 3... [NULL hitp/hrpb.mo... |05-2085000 [
U e 9 |BD0010 Institutional Bui... | Hospital Kuala ... |Jalan Sultan Idri... [NULL http://hkangsar... | 05-2085000 0|
1) M (10 | 800010 |Institutional Bui... | Hospital Sungai.. Jalan Felda Lasa... NULL | hitp://hsgsiput.... | 05-5983333 1o
{2 {No_paxs W Esnoom Institutional Bui... | Hospital Taiping | Jalan Taming Sa... [NULL http://htaiping.... |05-8204000 o
|8 |ID_DAERAH 12 | BD0010 Institutional Bui... | Hospital Seri M... | 32040 Seri Manj... [NULL http://hsmanju... | 05-6896600 0}
;,_Mm N 13 | 800010 :lnsmuticnal EuL..:Nosp«ll Chang... :moo Lambor... |NULL http://hcm.mo... :os-zmsz; :o
fol 14 | 800010 Institutional Bui... | Hospital Selama | Jalan Taiping, 3... |NULL http://hselama.... |05-8394233 o]
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Rajah 6 : Paparan /nsert Field bagi 7able Managers Rajah 7 : Paparan Attribute Table selepas
melaksanakan /nsert Fields.

Langkah 6 Mengisi data yang sama dalam setiap rows di dalam aftribute table menggunakan fools
MultiEdit. Klik Vector > Pienocampo > MultiEdit

# Multigdit )
MultiEdit 0.5
(C) 2013 by Giuseppe De Marco
5@ 13 Gumeme e -
Layer [ Field to write lh.uluu to: [ Create Field (Optional)
Hospital Perak v | |5 £ Abute bl - Hospial Peak= Featrestoa 15, Bterd: 15, seeced: O # Astribute table - Hospital Perak = Features totak 15, Bered: 15, selected: 0
7|8 %) | &) | %) [1] 8] [ |F /|8 ESIEN I EAEIE IS
Field Field type At S W}
= > /o | A | N [ e || mw o | O T L s
[1nu |- String Create new Field o 6omio atitutionl BuL | opia Sk R 35600 Sk River | [Horpan itpe//ma] [0 800010 Institutionsl BuL Hospial Sk R | 35800 Skm Rive | Hospial g/
1| 800010 Institutional Bui_. | Hospial Tapah | Jalsn Temoh, 35_| NULL hetpe//ne] 1| 800010 Institutionsl Bui_. | Hospital Tapah | Jalan Temoh, 35_f Hospital et/
Old Attribute value New Attribute value . 2_|s00010 Institutionsl Bul... Mospital Teluk L Jalan Changkat | NULL hetp/e| |7 800010 Institutional Bui. Hosptal Tehuk L. | Jalan Changkat | Hospital Ihetp/
3 |800010 Instttions Bul.. Hospital Gerk  Jaian ntan, 333..| NULL e | |37 so00i0 Intitutionsl Bui. Mosptal Genk JalanIntan, 333.. | Hospital oLt
ML & ll"“"“‘ I 1800010 Institutional Bu_ | Hospial Kampar  Jalen Hosptal | NULL o | [3 ] soo00 Institutionsl Bu | Hospital Kempar |Jalan Hosptal — | Hospital ot
|5 | 800010 Institutional Bul...| Hospital Part B... Jalan Sempada.. | NULL hetpe/hgl |5 | 800030 Institutionl Bui_. Hospital Parit 6... Jalan Sempada... | Horpital et/
~ 6 | 800010 Tnstitutionsl Bui... Hospial Bahage... 31250 Tanjung .. | NULL hetp/h [ 800010 Institutionsl Bui.. Hosptal Bshagi... 31250 Tangung .. | Hospital [rtp N
Select Clear Selected Write value it 7 800010 Institutionsl Bui. Hospital Batu G... Jalan Changat,_| NULL hatp//hY |7 | 800010 Institutionsl Bui... Hospital Batu G... Jalan Changkat.| Hospital =
Features Features to chosen field 3800010 Tnsttutionsl BuL. | Hospital Rajs P | Jaian Hosptal3_| NULL g/ 3800010 Tnstitionsl Bui | Hospital Raja P Jalan Hosptal3_| Hospial bretp
9 _|6800010 Institutional Bui. | Hospital Kuala . Jatan Sultan idn_| NULL hetpe//nid 9| 800010 Instautionsl Bui. Hospial Kusla —. | Jalan Sultan Idn_| Hospaal pretp//
10 | 800010 Institutional Bui. Hospital Sungai_. Jalan Felda Lasa| NULL hatp//he| | 10| 800030 Institutionsl Bus Hospital Sungas_ Jalan Felds Lasa_| Hospaal Prerp
5'3;‘:&"‘:‘&;‘3“ Exit 11 800010 Tnstitutionsl Bui_.| Hospital Taping | Jalan Taming $a.| NULL g/ (11 800010 Institutionsl Bui | Hospital Taping | Jalan Taming Sa_| Hosptal Iretp/ 1}
O 12| 800010 Tnstitutional Bui.. Hospial Sen M._. | 32040 Sesi Many| NULL hetpe//he| | 12| 800010 Institutionsl Bus. Hospital Seri M... | 32080 Sen Many._| Hospital [rete
P 13 | 800010 Institutionsl Bul... Hotpital Chang... 32900 Lambor .. | NULL hetp//nd |13 800010 Institutionsl Bui.. Hospital Chang... 32900 Lambeor ... | Hospital Iretp:/ /N
Z‘F::;:r'ﬁ/: :"::n:‘l’hmk 14500010 Tnstitutional Bui. Hospital Selama  Jalan Taiping. 3| NULL tpe// |14 800010 Institutionl Bui. | Hospital Selama | Jalan Taiping, 3.. | Hosptal [etp
in Field--> INU
Value to be modified--> NULL
[ I i e
4 Show M Festres ¥ Show A Festres |

Rajah 8 : Paparan lima(5) langkah bagi Rajah 9 : Paparan Attribute Table sebelum dan selepas
pengemaskinian data pada column yang sama. dikemaskini dengan menggunakan MultiEdit.
Contoh data yang digunakan adalah hospital.

Memaparkan data di atas [eeR B - hicaa = s B s ABBRBGan

. pythen Conscle
" Asuth and Distance Calaudator >
GRass

VRS ZRAR LBAQVLV-ER2 OB %

Google Maps dalam Quantum |°" "
GIS. Klik Tool Plugins > Open
Layer Plugins

Langkah 7

[ Add Stamen Terran-USA/OSM layer

Rajah 10 : Add Google Hybrid Layer > Zoom to
Layer Extent. Hasil daripada data yang telah
dikemaskini di atas Google Maps.
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Mendaftar Peta menggunakan Perisian Quantum GIS 2.10.

Langkah 1

7 Q@S 2301-Pen - — [=NTot

Klik Raster pada bar menu, kemudian pilih Georeferencer.
Kemudian, antara muka Georeferencer akan muncul seperti dalam rajah di bawah.

B BRSSO i ¢ v wioncaps P W SIS & - T
A/ BSRAD < on.. . 2 @ Fle Edt Vew Settngs

- @5 [ @ e » P | % | » @ Q ! \
revY®2Q e W > (338 @ 0% B L RO QA Sa ekt fie

P bl &%)
Vebe | D | SosceX | Sascet | DestX | DestY | oXwes) | dvoes) | Reshmooes) |

Transform: Linear Translation (101. 169, 5.75893) Scale (0.000238968, 0.000239435) Rotation: 0 Mesn error: 0.180087 | -322,4 |None | |

[ — LeaLasss Scke 198 v ot (00 S X Qs .]

Untuk set paparan georeferencer klik menu Setting dan pilih Configure Georeferencer.
(=L LELWPA  Pilih Show coords - Point tip, tandakan Pixels - Residual units. Pdf report - left margin 2.0mm,
right margin 2.0mm. Pilih A3 (297 x 420mm) - PDF map. Klik OK.

# Georeferencer - amanjaya cfs - pi2jpg ] | v —ar l ﬂ < L_,"@ =)
Fle Edt Settings - s
T ” 7 o [SF @ o  Configure Georeferencer
B> 530 @ »»%pg O PL0
Point tip
Show IDs
% Show coordinates
Residual units
® Pixels
Use map units if possible
POF report
Left margin 2.00 mm as
- . — 7
Right margin 2.00 mm ag
POF map
&%)
vsbe | © | soucex SorceY | DestX | Desty | ox(onels) Paper size A3 (297x420 mm) -
Show Georeferencer window docked
(o ]| e
i
Transform: Linear Transiation (101. 169, 5.75893) Scale (0.000238968, 0.000239435) Rotation: 0 Mean error: 0. 180087 | 32,4 Nooe | |

Georeferencer Plugin adalah alat untuk menghasilkan world files (fail
text ASCIl yang mengandungi maklumat khusus berkenaan koordinat
berformat bagi imej yang mempunyai hubungan dengan permukaan
bumi) untuk imej raster. la membolehkan pengguna untuk merujuk
raster kepada sistem koordinat geografi atau unjuran dengan
mewujudkan GeoTIFF baru dengan menambah world files untuk imej

yang sedia ada. Pendekatan asas untuk raster Georeferencing adalah
untuk mencari titik/ lokasi pada imej raster di mana pengguna boleh
menentukan dengan tepat koordinat mereka.
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Memasukkan titik-titik kawalan.

L Klik Open layer . Pengguna boleh mula masukkan empat (4) titik kawalan seperti di
angkah 3 g
rajah di bawah.

e 8 @ >g %

VRL2LL QM o=t fie ik

Open raster

Trangaton (0, ), 6. -267,62 || None |

Klik butang Add Point >, untuk memasukkan titik dan koordinat ke tetingkap
%

Georeferencer.

Terdapat dua (2) pilihan untuk menambah titik iaitu :-
i) Klik pada imej raster dan masukkan koordinat (x,y) secara manual.

Id Latitud (x) Longitud (y)
1 5.648512929 | 101.2267573
2 5.649823481 101.678154
a3 5.468944445 | 101.6786121
4 5.467628265 | 101.2273488

ii) Klik titik pada imej raster dan klik butang From map window untuk menambah koordinat
(x,y) dengan bantuan peta bergeoreferensi yang telah sedia ada dimuatkan dalam map

canvas.

——
7 R
K _Entev map coordinates

point.

—— (2 o)

Enter X and Y coordinates (DMS (dd/mm ss.ss), DD (dd.dd) or projected coordnates (mmmm.mm))
which with the selected point on the image. Alternatively, dick the button with icon of a
pendl and then dick a corresponding point on map canvas of QGIS to fil in coordinates of that

| ¥ /North

(i |[7e=T

Snap to background layers

(ii)

[ o« | [ZFommepcnves] conce

Memasukkan empat (4) titik, semakin banyak koordinat pengguna berikan, ketepatan lebih
tinggi dan kemudian klik butang Start Georeferencing > .Kemudian, Klik OK.

Nota :

Ketepatan residual adalah +0.01



e

Pada tetingkap tetapan Transformation ; pilih Linear -
Transformation type, pilih Nearest neighbour - Resampling
. method, pilih NONE - Compression dan namakan semula
-2 mdted . hasil raster - Output raster. Kemudian, Klik OK.

Compression  None -
Create world fie only (inear transforms)
Use 0 for transparency when needed

Resamping method Nearest neghbour

“ Target SRS Selected GRS (EPs:4325, W v @

Set target resokston

P 4

Rajah di bawah menunjukkan peta telah berjaya dilakukan dan boleh melakukan proses

% Georeterencer - smanjeye cfs - p2jpg (= @ il
Fle Edt Vew Settngs
< ¥ < 5P
B » % rr{}g O2L0LR ot eof  J
I i
o |
~1X 101678154
A ~ |Y 5649823
!
I i
\/—/"ﬁ}\!
X 101678612
Y 5468944
GCP able &%
vete | © [ sosex | soscer | cetx [ ooty | aoue [ crooed | resdwones
x ° 24L.4% 461164 01227 5.6485 ©0.178433 0.000159265 0.178433
x 1 2% 455.69 10167 5.64982 0.00675137 0.000320774 0.006758959
% Jmn @i WLen  ess  ooeese  o.0amal cozseass
x 3 243.564 -1216.61 10127 5.46763 0.17864 0.0225406 0.180056
Transform: Linear Translation (101169, 5. ).000238968, : 0.180087 1505,-558 None 4

Langkah 4 Tambahkan imej raster sebagai peta asas mengunakan butang Add raster layers. '

Nota : Bagi cara-cara mendigit peta, sila rujuk edisi lepas buletin sesi 1/2015.

Rajah di bawah menunjukkan data gunatanah selepas melakukan proses Digitizing.
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KESELAMATAN MAKLUMAT

KESELAMATAN TELEFON PINTAR

Telefon pintar telah menjadi sangat popular dan ini terbukti dengan peningkatan kadar penjualannya di seluruh
dunia.

Telefon pintar adalah peranti komunikasi yang canggih berbanding telefon bimbit tradisional. Peranti ini
membolehkan kita untuk melihat laman sesawang yang direka untuk platform PC dan pelbagai jenis aplikasi yang
boleh dimuat turun secara percuma.

Versi terkini Sistem Pengoperasian (OS)*1 dan aplikasi*2 pada telefon pintar kerap dikemaskini*3. lanya akan
menambah baik fungsi telefon pintar dan seterusnya meningkatkan fungsi keselamatan.

*1 - OS adalah singkatan kepada sistem operasi yang merupakan perisian yang mengawal PC atau telefon pintar. Sebagai
contoh di dalam Komputer Peribadi (PC), OS menguruskan pelbagai jenis fungsi-fungsi seperti /0 (Input/Output) yang
mengawal input daripada papan kekunci, output untuk paparan, atau pencetak.

*2 - Aplikasi adalah perisian untuk tujuan tertentu, seperti pemprosesan perkataan, atau membuat hamparan. Pengguna boleh
memilih aplikasi yang mereka perlukan, dan menggunakannya selepas membina dalam OS yang mempunyai fungsi asas yang
biasa digunakan oleh setiap perisian.

*3 - Kemas kini bermakna pindan kecil perisian untuk membetulkan bug, atau menawarkan penambahbaikan. Dengan
menggunakan fungsi ini, pengguna boleh sentiasa mengemas kini aplikasi yang dipasang dengan versi terkini. la juga penting
untuk mengemaskini perisian keselamatan untuk menjamin keselamatan maklumat.

RISIKO DAN ANCAMAN

Bilangan malware yang menyasarkan telefon pintar semakin meningkat. Jika peranti anda dijangkiti oleh malware,
maklumat peribadi seperti senarai nombor telefon dan maklumat peribadi lain mungkin dihantar ke pelayan luaran
atau mungkin berlakunya transaksi caj yang tersembunyi.

Selain dijangkiti oleh malware terdapat aplikasi yang dimuat turun akan menggunakan maklumat di dalam peranti
atau meminta kandungan di dalam buku alamat untuk dihantar ke pelayan luaran. Sebagai contoh, terdapat aplikasi
yang mendakwa direkabentuk untuk meningkatkan hayat bateri. tetapi sebenarnya ia menghantar maklumat buku
alamat atau senarai nombor telefon terkandung di dalam peranti tersebut kepada pihak luar.

LANGKAH KESELAMATAN

Pastikan OS, aplikasi dan perisian anti-virus telefon pintar anda sentiasa dikemaskini dengan versi terkini. Ini adalah
kerana telefon pintar mengandungi maklumat sensitif dan peribadi lain yang perlu dilindungi.

Apabila memuat turun aplikasi, pastikan untuk memeriksa keaslian dan tahap kebolehpercayaan pihak yang
membangunkan, menyedia dan membekalkan aplikasi tersebut. Pastikan anda menyemak terma dan syarat
perkhidmatan berkenaan maklumat yang akan dikumpul dan bagaimana ia akan digunakan sebelum anda
memberikan persetujuan untuk menggunakan aplikasi tersebut.
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KESELAMATAN RANGKAIAN TANPA WAYAR (WIRELESS LAN)

Sejak kebelakangan ini, komputer peribadi telah menjadi lebih ringan dan kompak, serta penggunaan telefon pintar
menjadi lebih popular.Tahap penggunaan Rangkaian Tanpa Wayar (Wireless LAN) yang meluas membolehkan
pengguna mengakses internet dimana-mana sahaja sama ada di rumah mahupun di pejabat.

Selain perkhidmatan berbayar yang disediakan oleh Penyedia Perkhidmatan Internet, penggunaan Wi-Fi awam
secara percuma yang disediakan di lapangan terbang, stesen kereta api dan bangunan komersial juga turut
meningkat.

RISIKO DAN ANCAMAN

Memandangkan penggunaan Rangkaian Tanpa Wayar (Wireless LAN) yang meluas dan terbuka, capaian
komunikasi tersebut berisiko terdedah kepada pintasan oleh pihak yang berniat jahat, melainkan langkah-langkah
keselamatan dan pencegahan telah diambil oleh pengguna.

Selain itu, pencerobohan terhadap Rangkaian Tanpa Wayar (Wireless LAN) mungkin menyebabkan kebocoran
maklumat peribadi atau rahsia syarikat, dan ianya berpotensi digunakan sebagai landasan untuk serangan ke atas
sistem rangkaian/komputer lain. Apabila menggunakan perkhidmatan Wi-Fi awam, PC atau telefon pintar anda
mungkin disambung ke Rangkaian Tanpa Wayar (Wireless LAN) yang palsu. Sekiranya ini berlaku, sesi capaian
dan komunikasi anda bermungkinan besar sedang diperhatikan.

LANGKAH KESELAMATAN

Pastikan tetapan keselamatan capaian router Wi-Fi anda ditetapkan kepada tetapan seperti WPA2 (Wi-Fi Protected
Area Access 2) dan sebagainya. Ini memastikan capaian komunikasi sukar untuk dipintas serta menghalang capaian
yang tidak dibenarkan. Apabila menetapkan tetapan enkripsi secara manual, pastikan penggunaan aksara secara
rawak dengan bilangan aksara yang bersesuaian.

Apabila menggunakan perkhidmatan Wi-Fi awam, sila gunakan laman sesawang berformat SSL*4 (laman
sesawang URL yang bermula daripada "htfps://") sahaja dan sila nyahaktitfkan tetapan perkongsian fail di peranti
anda sebelum menggunakan perkhidmatan Wi-Fi awam tersebut.

*4 - SSL adalah singkatan kepada Lapisan Soket Selamat (Socket Secure Layer) yang merupakan protokol untuk menyamarkan
data yang dihantar di laman sesawang.
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AKTIVITI 12

Hari Terbuka PerakGIS
Tarikh : 12hb Ogos 2015
Lokasi : Unit PerakGIS,PTTC,Meru.

Majlis Perasmian Viaduct & Tapak Projek Tropical Rainforest Living Collection Banun.
Tarikh : 22hb September 2015
Lokasi : Hutan Simpan Amanjaya Gerik,Perak.
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Mesyuarat Jawatankuasa Teknikal Geospatial Negeri Perak bil. 1
Tarikh : 1hb Oktober 2015
Lokasi : Pejabat Setiausaha Kerajaan Negeri Perak.
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19th Esri Malaysia User Conference 2015
Tarikh : 20hb - 21hb Oktober 2015
Lokasi : PICC,Putrajaya.

19th Esri Malaysia User Conference GIS for every generation
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Kursus ArcGIS Desktop
Tarikh : 2hb - 5hb November 2015
Lokasi : Pusat Internet 1 Malaysia,Manjoi,lpoh.
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AKTIVITI

Bengkel e-Desa
Tarikh : Oktober - November 2015
Lokasi : Pejabat Setiausaha Kerajaan Negeri Perak.
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geographical information system

Unit PerakGIS Negeri Perak
Tingkat 13, Techno Trade Centre (PTTC),
Off Jalan Jelapang, Bandar Meru Raya,
30020 Ipoh, Perak Darul Ridzuan

05-5262581

=] 05-5264908
@ sgdcperakgis@gmail.com
www.perakgis.my



